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INTRODUCTION
WHAT IS THE GLOBAL CONTENT REPOSITORY ?

The Global Content Repository (GCR) is a Lotus Notes database that stores all of
the content for ey.com, enables creation of new content, and posts it to ey.com.

The GCR User’s Manual, like the GCR itself, is an evolving document and it is our
intention that this third iteration will be updated in due course. For accompanying
information on Ernst & Young websites and branding best practices please refer to
the Global Web Site User’s Manual .

You will find basic operations of the GCR similar to other Notes databases you are
used to - for example, you access Ernst & Young email via a Notes database.
Double-click on any document to open it; to delete any document, select it and
press your ‘Delete’ key.

A NOTE ON R5

Over the next several months Ernst & Young member firms are scheduled to
upgrade to Notes R5. Operations in the GCR are largely unchanged by this
upgrade, but this manual includes notes on the few differences between 4.6 and
5.0.



Below is the By Site view of the GCR
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Clicking Admin Tool reveals:

« User Profiles
* Keywords
+ Site Profile

» Section Templates

* Resource Files

» Country Navigator

+ Broken LInks



ABOUT USER PROFILES

When you are given access rights to the GCR your profile is created by the
Shared Services team, but you will be able to modify it at any time. It is this profile
which allows you to access the relevant parts in the GCR that you need.

Global Content Repository [
My Profile: = K
Mame: Twdebmazter/EY-APPAUS o= o
R ole: T Content Manager 1 =] Caneel
Cauntry: " United Kingdam =1
Local Time " Greerwich Mean Time ;=1
[ one:

Telephone: [ 4

Fax: ry

Email addresz: |7 4

Preferences:

| normaly develop pages for: rlnternatiunale

L;‘;’g”_‘a"y deviop pages ® HTML C WYSMYG O Prompt each time

| prefer to preview content in: ) Prompt each time () Netscape Mavigator

(@ Internet E=plarer

F
The Template | n_u:urmall_l,l J=

develop cantent in iz

The language | normally " English ;=1

develop content in iz -

This is the protected text area of the form.




DOWNLOADS

Website Asset
Siter Swveden
Az=et Mame MACRG

Fedquires Redgistration: C vesz @ no

Az=et Size
Az=et Owener

Attachment E I

MINAPD

URL to link to Iglobalfvault netrzvwedenMaC A EfileMCHa pof
[press F9to refresh)

Description:
Camments:

Taxonomy:

Taxonomy:

Country: Swveden

Incdustey:

Service Line: Management Consulting Service line
SuUb-graugp:;

Topic:

Langusge:

Document Type:

E&Y Specific:

Downloads such as the Adobe Acrobat .pdf's are stored in a separate database
called the Global Vault. As with images, downloads can be added to documents
using GCR tools.



IMAGES

Image file
General:

Site: S 4=

Image Tite Traders

Description: F g

LRL: <G Height=194 wOTH=230

SRC="YGLOBALgcr.nsffimagesf5248 B 1 AFS240CO62302 56323007 24006 FF ILEcustoms _traders .gif">
Attributes:
Width: T30
Height: T4
AftText: T
Attachment:
AttachHame: custom=_traders.gif
Size: 11,326
File: r é
t.fL_Jfx'I'GIs"f'\S_'I'I'-'uﬂ\.I::'EJ
Presview: r
|

Taxonomy:

Country: "=

Incustry: S|

Service Line: T Tax gz Service line T Customs Dty =]

FUb-group:;

Topic: Tzl

Langusce: TEnglish ;=]

Documert Type: |

E&Y Specific: |

Image Type: T Phata a2

P

Image Concept:

currency, players, time =]

Images for ey.com are also stored in the GCR. Site managers attach images to
documents, apply taxonomy parallel to the content and then use the GCR tools to
incorporate images into the web pages.



TECHNICAL REQUIREMENTS

APPLICATIONS

Country web teams preparing for migration should plan to obtain the following
software:

[0 Lotus Notes 4.6; (the GCR is a Lotus Notes database).

0 Photoshop 5.5 (for creating and editing graphics for the site. Photoshop 5.5
incorporates a software add-on called Image Ready which is specifically
designed for creating web graphics.

[0 Adobe Type Manager 1.0 (for adding fonts to your system)

BROWSERS

The aim of all Ernst & Young national sites is to be as accessible as possible.
To this end, we request that you build your pages with functionality for both
Netscape Navigator and Internet Explorer in mind. The site is optimized for the
latest browser versions but must be compatible with 3.0 browsers. Browser-
detection scripts built in to the system address site-wide issues such as
navigation.

For any additional applications, please keep lower end users in mind. If primary
means for communicating information is only accessible via advanced features,
please provide a regular content page with the information as well.



REPLICATION - HOW IT WORKS

There are copies of the GCR database on three servers, in New York, London and
Singapore. Users should access the server closest to them e.g. Australia should
access Singapore, the Netherlands London etc. Externally there are two live web
servers also hosted in New York. Content is synchronized between the databases
on these servers by Notes Replication.

The databases on the internal servers are replicated every 30 minutes. The server
in New York then replicates with the live web servers, also on a schedule of 30
minutes. Therefore if you make a change on the Singapore or London servers it
should replicate onto the live site within the hour. All pages replicate onto the live
servers whatever their status however they cannot be accessed unless you link to
them from another page.
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TAXONOMY

DEFINITION OF TAXONOMY

A taxonomy is a hierarchical, controlled vocabulary used to classify and organize a
large body of information.

HOW WE USE IT

Specific to the GCR, taxonomy determines how content is viewed within the
database. It also determines what content is automatically displayed in the
‘Search’ box.

Using a consistent system of words to classify content makes it possible for the
GCR to remain well-organized and navigable even when used by hundreds of
people and filled with thousands of documents.

In an expanding database like the GCR, correct taxonomization of all content; like
web pages, images or otherwise is essential. Whenever a new piece of content is
created in the GCR, users are required to fill in various form fields. These enable
the finished content to be classified with similar content.
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The taxonomy serves the needs of both site managers and users in the following
ways:

* Helping site managers navigate the GCR
» Helping users navigate the site

HELPING SITE MANAGERS NAVIGATE THE GCR

U VIEWS

Each view in the GCR is based on the taxonomy. By using the taxonomy, content
can be organized so that all users of the GCR can easily find what they are
looking for. Please see Browsing and Searching for further information.

U LINK, IMAGE & DOWNLOAD TOOL

The tools for inserting HTML tags for links, images, and downloads are all based
on taxonomy. For example:

Inzert Link E

Link type: ) External @) |ntemnal _

— Internal Link Select: ——— — Properties:
Site:

) . _ 0 i

| International jl Link. test: [T Ovenarite

Cancel

T axanarm: | |

1 Industries ! Topics
(@ Sepvices (! EY Categories

Services:

Entrepreneurial Services
Information Systerns Advison & Asa ™

Subcateqon:

Caszh Management
Finanicing
Forenzic Accounting &

Pages:

Brand %/ aluation - Corporate Financ: .
Brand %/ aluation? - Carporate Finand |
Brand*/aluationd - Corporate Finarn:

European Acquisitions - Corparate F—
Services - Corporate Finance ~
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HELPING USERS NAVIGATE EY .COM

[J SEARCH ENGINE

When users click on the search button, they not only get the option to search, they
also get a list of all of the pages appearing in that category; in other words, the
search engine is context-sensitive. The screen shot below shows what will appear
when users click search in the ‘Energy’ section.

The taxonomy you assign to a page determines the initial links displayed in the
search results window (see below) when users are browsing that page.

; Ernst & Young - Search - Microsoft Internet Explorer pro... [l[=] E3

EERNST & YOUNG

FROM THOUGHT T FINISH ™

Search

search by keyword:

| Gul Cancel |

Al of Ev ™ Energy ©

Energy:

. Energy - Library
Energy Dowunload Librany
Site: International Language:
. Chenview - Qilpipeline - Energy - Ernst & “oung LLP
Helping oil companies develop innowvative methodalogies to adapt to new t
and new cost and environmental demands.
Site: US Language:

B EHERGY vearbook 99 - Energy
Fiwve articles referancing Energy issues in focus.
Site: International Language:

. Enterprise-wide Risk Management - Energy -
4| | b
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EY.COM TAXONOMY COORDINATES:

[J SERVICES
Sub-Services

[J INDUSTRIES
Sub-Industries

J E&Y CATEGORY

This coordinate includes primary sites like About E&Y, Library, and News
Room.

J ToPICS

This coordinate is designed for cross-disciplinary subjects like eBusiness and
Risk Management.

J LANGUAGE

This coordinate currently includes twelve languages but more can be added as
needed.

[J COUNTRIES

This coordinate includes all countries. It is possible to assign more than one
value for this coordinate, so if a document is relevant to more than one country,
more than one country can be selected.
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[J DOCUMENT TYPE

Values of the document type coordinates are defined in the table below:

Article

Analysis of a topic, usually a page to several pages long.

Collaboration

Threaded discussion group.

Contacts

Page containing contact names, telephone numbers and the like.

Events

Conferences, programs or seminars attended by or sponsored
the firm.

Feature Story

Story written for non-experts on an E&Y related subject.

Multimedia

Audio, video, or interactive games.

Newsletter

A periodical publication filled with short articles on a variety of
topics related to the practice or industry.

Press Release

News briefs issued by the firm.

Profile A biography of a professional within the firm.

Record Description of a publication, lengthy or short, with information
regarding ordering information rather than the actual report itself.

Report A written account providing E&Y analysis of some topic. ‘Reports’
may have many permutations. Usually, a report is a detailed
overview of a business issue affecting the industry group or
service line. E&Y ‘Studies’ are included in this category.

Resources Frequently Asked Questions, Glossary, Helpful Tips, Hot Topics,
Links.

Service Information regarding services, including overview pages.

Description

Success Stories

Case studies and project descriptions which highlight E&Y
knowledge and expertise.

Survey A questionnaire; interactive surveys allow users submit answers
to questions online. Other surveys may be printed out and faxed
or mailed.

Tool A specific functionality that allows the users to do something in a

self-service mode.
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U IMAGE TYPE

Advertisement Ernst & Young Internet or print ads; animated or single frame.
Animation Animated graphics.

Book Cover Graphic from the cover of printed or .pdf version of a book or report.
Chart/Diagram Informational graphic; designed to convey statistics, organization,

process, etc.

Horizontal Rule

Lines used to divide areas on pages.

Icon

From our ad campaign.

lllustration

Drawing, sketch or other non-photographic and non-informational
image; in nearly all cases illustrations are not in keeping with Visual
Identity standards and should be avoided

Jargon Watch

Images used exclusively for the Javascript vocabulary game in
Ideas@Work.

Logo Corporate Identity, Product Identity, Event, Graphic.

Lozenge Services & Solutions, Also See, etc. the rounded oblong graphics
used to break up text on Welcome pages.

Photo Photograph; note all photos used on ey.com should have rounded
corners (see masking instructions in Photograph Finishing ).

Portrait Photograph of a person for purposes of identification and promotion.

Often used as part of a profile or testimonial.

Splash Screen

Image presented to users when they first log on.

Title Graphic

Text at the top of a page used to identify the section of the site,
whether its a service or industry specific page (blue text with
underline) or a primary site (long rounded oblong shapes for About
E&Y, News Room, etc.).

J IMAGE CONCEPT

This coordinate is used to organize the photographs used as accent graphics on
the site by the content of the image.

building
calculation
clock
communication
computer
cooperation
creative
currency
decisions
education
family
flying

focus men science
global merger sport
growth motion strategy
help multicultural network success
ideas numbers technical
information office technology
knowledge people time
landscape phone woman
learning players world
leisure research young
light risk
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BROWSING AND SEARCHING
BROWSING - A DEFINITION
Browsing is a means of viewing the content stored within a Lotus Notes database.

Views can be engineered to highlight different coordinates of the content. Below is
the ‘All Content By Site’ view of the GCR.

| . Global Content Repozitory - ContentVAll Content-5ite - Lotus Notes

R

Global Content | li
Repository b EXYPSLLC
¥ Einland
ﬁ' My Documents » France
i b Germany
My profile k International
My ‘work b Ireland
b ltaly
@ Content b Jersey
by Site F Mexico
by Status F NHew Fealand
by Document Type » Horway
b Poland
E Images b Prototype
b Sit k Singapore
o b South_Africa
by Type b Spain
B Lo F Sweden
F Switzerland
':b Admin Tool b UK
|F us
@ http: / fwww_ey_com

Views show all the content in the GCR, sorted by the values of the coordinate
used to build the view. The small triangles to the left of each value are called
twisties. Clicking on the twistie will reveal the documents which have been
assigned that value.
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Your email inbox is also a Notes View, and basic operations are similar. To open
any document, double click on it. To delete any document, use the delete key. A
trash can will show up in the narrow column to the left of the content. All content
marked with a trash can will be permanently removed from the database when you
press F9 to refresh the view, or when you close the GCR.

CONTENT VIEWS

Clicking on the turquoise buttons to the left calls up the various views. Current
content views are:

* My Work - Shows all of the documents where your name appears in the author
field

* by Site - Generally the most effective view to use: organized first by country,
then by all taxonomies within the country.

» by Status - Useful for managing workflow.

» by Document Type - Ideal for finding & editing specific types of pages.

Documents will show up in Not Categorized unless they've been assigned a value
for the coordinate being viewed. e.g. A Parent value like Tax is associated with
Children: International Tax, Transfer Pricing etc. Those documents not assigned a
child value will show up in Not Categorized. Therefore the international site Tax
Welcome Page is found under Tax =»Not Categorized.

IMAGE VIEWS

Image Views are organized by:

» Site - Same as the Site view for content. Most useful for finding charts and
company logos specifically associated with one area of the site.

* Type - As many images are used sitewide, this view is sorted by the type of
image, e.g. horizontal rule, lozenges, etc. It is most useful for finding standard
site graphics.

» Concept - Styles of images are grouped together e.g. buildings, people etc.

ADMINISTRATIVE VIEWS

Several of the documents used to administer and maintain the database are also
accessible via views. Clicking on the Admin Tools button reveals views of the
User Profiles, Section Templates, Resource Files, Broken Links and Section

Templates. Each of these functions are addressed in the How To section.
User Profiles

Keywords

Site Profile

Section Templates

Resource Files

Country Navigator

Broken Links
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SEARCHING THE GCR

To launch the search bar, select View =» Search Bar. This tool will search the full
text of the GCR. Type in your terms and click Search. Only your results are
displayed in the view. When you open the documents from your results list, your
search terms will be outlined in red. To return to the complete view, click Reset.
Note: you cannot search when the My Work view is open.

DOWNLOADS

Downloadable documents (Adobe Acrobat files, Excel spreadsheets, applets) are
stored in the Global Vault, which is a separate database from the GCR. Like the
GCR, the Vault permits documents to be taxonomized by Site, Industry, Service,
Topic, Ernst & Young (E&Y) Category.

1.0 Global ¥ault - Azsetsh by Site - Lotus Motes Desktop

DEiIe Edit  %iew Create  Action: Window  Help

ClE A S =] £ &7 6] e
<:{Etreate new Agzet |

Web Assets by Site |
- Global % ault _
b Australia
w Q, Azsets * International
2, by Site - AABS
3, by fileMame 2nd Annual Glabal Information Security Survey  Filenare: 155 urvey39. pdf
P D cAdmin . S_ize: 216522
b Fraud; the unmanaged rigk. Filename: Fraud. pdf
%’ ;WET> Size: 237329
B Reality of rizk management - Dutch Wersion Filenarne: Dutch. pdf
Size: 205206
Reality of rizk management - Englizh Wersion Filename: RealityofR iskMat. pdf
Size: 207852
Realty of rizk management - French Yersion Filename: French. pdf
Size: 2114392
Reality of rizk management - German Yersion Filenare: German. pdf
Size: 276619
Reality of rizk management - [talian Wersion Filenare: [talian. pdf
Size: 274129
Reality of rizk management - Swedizh Version Filename: Swedizh, pdf

Click on the Assets twistie to reveal the two views available in the vault:

» Site - Organized like the Site view in the GCR
» Filename - Alphabetized by file name

Both views include the document size.
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FORMATTING STANDARDS

WYSIWYG USERS

Please ensure all text is in Arial, and the text color is black. All text should have
[None] indicated in the style pop-up.

[J WELCOME PAGES

All text in the feature column should be 10 pt except:
Headlines should be coded as [<H2>Headline</H2>]
Subheads should be formatted bold and italic

All text in the Also See column should be 8 pt.
Headlines should be formatted bold and italic with
a single paragraph break at the end of the line.

[J UNDERLYING PAGES

All text should be 10pt except:

Headlines should be coded as [<H1> Headline </H1>]
Subheads should be coded as [<H2>Subhead</H2>]
Press Release Headlines - Preferable to use <H2> for
them as they tend to be long

20



HTML USERS
Please ensure all text is in Arial, and the text color is black.

For Notes 4.6: All text should have HTML indicated in the style pop-up menu
(lower left corner)

Choose any of the HTML options available in the menu. The redundancy is
a bug in Notes.

Enter your HTML here:
First Column:

aun | Beratung und Assi
trater ! itellen. Dabei wend
il i “Headline dia Iht Untetmehme
rafile et die _|r ._.rlttern{:! lagl=!
et Mindestanforder

aren Installation. Da

lzichen, die

|Default Sans ‘| 1D‘|[Nnne] ‘|
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For Notes 5:

All HTML content will
appear shaded grey.

Leave the style pop-up
menu as [None]. Instead,
use the Pass-Thru HTML

option under the text menu.

Eile Edit “iew Create Action: EEGSE Help
{}@"% J@ liﬁ _@ B Teut Properties...  Chil+k
oy welcome 4 Global Conterl  Permanent Pen »
\ _ Highlighter 2
=] %Save Q WA Preview o PaseThi HTHL
= :
! K LI B N N Marmal Text Chil+T
'Q-B Prevent Raokbot Italic Chrl+l
Fi Inctesing: r Bold Chl+E
El Descrigion o~ © Qn_derline Crl+L
. Content: Strikethraugh
- } HTML Tags Elizets ¢
e Colar 3
Security: Enlarge Size F2
! Who iz this page T Bettina Reduce Size Shift+F2
ﬁ] aszigned to:
Align Paragraph r
g Workflow: List .
E;?IJ Status: rTl:I D a=l Epacing 3
B [ndent FB_
&l Content: Oukdent Shift+F&
Apply Style b
) Format:
Page Type: rHTHLJ_;I Section Template: Tyirtsch
Enter your HTML here:
First Column:
" zh3=<h=<i>Risikomanagement-Beratung</b=<fi></h3:
Ernst & Young bietet Ihnen Beratung und Assistenz auf
"Risikostrategie” sicherzustellen. Dabei wenden wir erpr
Risikoprofile zu erarbeiten, die |hr Unternehmen als Gan:
zur Werflgung. WWir erarbeiten Mindestanforderungen an |
und unterstitzen Sie bei deren Installation. Das Beratum
zusammen mit Best-Practice-Yergleichen, die Mithilfe be
angemessener Limitsysteme sowie die Klarung steuerlic
K3

“|'Y'ou have new mail.

| Default Sans “[ 10| [Mane]

If you try to use the
style pop up box to
indicate text as
HTML all text will
appear in a very
narrow column.

If HTML code is visible
when the page is viewed
on the site, it is because
these guidelines have not
been observed.
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HEADLINE & ALSO SEE FORMATTING STANDARDS FOR HTML USERS

J WELCOME PAGES

Headlines should be <H2>
Subheads should be bold & italic with a <P> before and <br> afterwards

ltems in the "Also See" column should be <H4>. Headlines for these items
should be bold and italic. For example:

<H4><B><I>Connect with Us</I></B><BR>

Looking for a tax professional? We're only a <a
href=/global/gcr.nsf/us/Contacts_- Tax - Ernst_ & Young_LLP>click
away</A>.</H4>

[J UNDERLYING PAGES

Headlines should be <H1>
Subheads should be <H2>
News Release headlines should be <H2>
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HOW TO ...
IMPORTANT GCR NOTE:
Please do not change the font as formatting errors may occur! For
documents created in Word, select all content and change the font to Arial
before copying it

ROADMAP

Different parts of the GCR contain the information for different parts of the site:

<Page

Section Template—>

<Site Profile

24



SITE PROFILE

The Site Profile contains the images and code required to display your site’s
masthead, all navigation on the left of the screen, and footer. The Shared Services
team will help you build and maintain your site profile.

CREATE SECTION TEMPLATES - ATTACHING RESOURCES TO THE DATABASE

The GCR uses Templates to facilitate swift development of web pages.

U

1.

U

1.

N

CREATE SECTION TEMPLATES

Under the left-hand navigation in the GCR, click once on the Administration
button to reveal the link to Section Templates, and click on it.

Click the New Section Template button, which is above the left-hand
navigation and below the top toolbar.

In the first field, your country or region should already be selected. If not click
on the drop-down arrow and choose the correct site from the menu. In the next
field, fill in a name for the template.

Leave link color on default unless you are building a template for a primary
site:

Light Blue - News

Green - Careers

Orange - Library

Purple - Ideas@Work

There is no special link color for About Ernst & Young. Please leave the link
color for this template on default.

CREATE SECTION HEAD

Create the Section Head .gif using the Photo Finishing tools. Ensure all words
are in capital (uppercase) letters.

Attach the .gif to the Headers Resource File.

Click on the Administration button to reveal the link to Resource Files, and click
on it.

Open your site’s Headers Resource File.

Double-click inside any field to change from read-only to edit mode (or Press
Ctrl and E).

Attach your new image, using either the paper clip in the tool bar or file attach.
It is advisable to attach all your images in alphabetical order.

Currently resources are listed in the drop down boxes in creation order. New

images created after the initial set are attached will show up at the bottom of
the list.

25



Copy your image to your hard drive before you try to attach it. Images
stored on floppy disks and then attached may show up with strange,
unrecognizable names once they are stored in the resource file.

The Resource file contains all of the headers for the entire site. If you try to
delete a gif file from the resource file, you must make certain you are in the
edit mode (Ctrl-E or double click in a field) to ensure that you are not
deleting the entire resource file, but only the gif file.

[J CREATE SECTION NAVIGATION

In the Navigation Title brackets, add a title to appear on top of the section
navigation box. The box, which will include links to pages within your subsite,
will appear on the upper right-hand side of your Web page.

Ideally, these menus should contain five to nine links. For service line &

industry group sites, the standard order of links is as follows:
Welcome

Overview

Services

Success Stories

Library

Contact Us

If the site doesn’t have all six standard items, at minimum please keep the
Welcome link first and the Contact Us link last.

¢ BUTTON DEFINITIONS!

Append; add a new link to the end of the list
Insert; add a new link in the middle of the list
External Link; link out of ey.com

Internal Link; link within ey.com

Remove Link; deletes an entry

It is not possible to edit links once you add them. If you have made a mistake, you
will need to delete the link and start over.

The HTML field is not editable. This is the code for navigation which will be
inserted on pages assigned to this template.

Once you have created your section navigation menu, upon viewing it in a browser

you may find that the vertical line no longer joins with the horizontal line. Please
use the Image Length option to increase the length of the vertical line.

26



BEFORE INCREASING LENGTH OF AFTER

VERTICAL LINE

Navigation:
Careers Mavigation title: ¥ Careers 4 Careers
-Wiglcome Image length: 150 +(% 20 45

-E&Y on Campus
-Job Search

-Career Paths
-Internships

-Welcome

-E&Y on Campus
-Job Search
-Career Paths

-Life Balance -Internships
i i -Life Balance
-Diversity . -
-Citizenzhip -Diverzity
-Citizenzhip

[J APPLYING GRAPHICS

Location button: select your site’s Headers Resource File.

Section Head: select the section head .gif you made using the Photoshop
tools.

1.
2.

If you have just added it to the resource file it will be at the bottom of the list.
If it is not there, press F9 on your keyboard and try again. If it still does not
show up, restart the GCR and try again.

Alt Text: type in the text you used on the header .gif

[J APPLYING SECTION TEMPLATES TO PAGES WITHIN YOUR SUBSITE

Choose Section Template from pop up list on every page.

On Welcome (two column pages), the Section navigation insert is built into the
template and you do not have to add it.

On underlying (one column pages), you will need to add the Section Nav:

1.
2.

3.

a)
b)

C)
d)

Click in the top of the Content field, immediately after the opening bracket
under “Enter HTML Here”.

Click Other Tools button in the lowest tier of the upper tool bar (far right
position).

Select “Insert Section Nav Include”.

Wait... this will appear shortly: <<< Section Nav Insert >>>. It should be
located right after the opening content bracket. If your cursor was not
located in the appropriate location before you select the Section Nav insert,
the include file could appear in the wrong location on the page and won't
function properly.

Highlight and copy the <<<Section Nav insert>>> coding.

Go to the next page in the section, select the same Section Template and
paste <<<Section Nav insert>>> at the beginning of the content field.
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ADDING IMAGES TO THE GCR

Image file

General:

Siter S 4=

Image Tite Traders

Description: F g

URL: <G Height=194 wOTH=230
SRC="YGLOBALgcr.nsffimagesf5248 B 1 AFS240CO62302 56323007 24006 FF ILEcustoms _traders .gif">

Attributes:

Wlctth: Fosn

Height: T4

AltText: T

Attachment:

AttachHame: custom=_traders.gif

Size: 11,326

File: r é

CUSTOMS T I'-hﬂ\.IZ:'EJ

Presvie: C
d

Taxonomy:

Country: "=

Incustry: S|

Service Line: T Tax gz Service line T Customs Dty =]

FUb-group:;

Topic: gl |

Language: "English ;=1

Documert Type: |

E&Y Specific: |

Image Type: T Phata a2

Image Concept: J"uzurrenc'-,-', players, time =]

1. Click on any of the image views, then click the ‘Create New Image’ button.
2. Choose your site from the menu.
3. Under ‘General’, provide a title and description.

Concise and logical titles please!



4. The ‘Attributes’ fields are optional but we strongly advise that you complete
them. By adding width and height the browser knows to reserve space for the
image and can continue building the page as the image downloads. Without
these attributes the browser needs to wait for the image to download before it
can finish building the page. Alt text is what users will see if they turn images off
or if they roll over the image)

5. Click in the File field, and click the attach a file button, which will allow you to
browse for your image file. When you find it click open. The GCR will
automatically add a preview of the image to the next field.
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ADDING DOWNLOADS TO THE VAULT

YWebsite Asset

Siter
Az=et Mame

Requires Registration:

Az=et Size
Az=et Owener
Attachment

URL tolink to
[press F9to refresh)

Description:
Camments:

Taxonomy:

Swveden
M4
C ez (® Mo

)

MINAPD

Iglobalfvault netrzvwedenMaC A EfileMCHa pof

Taxonomy:
Country:
Incdustey:
Service Line:

Topic:
Langusge:
Document Type:
E&Y Specific:

N =

Swveden

Management Consulting Service line
SuUb-graugp:;

Open the Global Vault and click the ‘Create New Asset’ button.
Choose your site from the menu.

3. Provide a name. Avoid the punctuation marks that are prone to cause problems
in document titles.

4. Currently the Registration option is not available, and the Asset Owner and
Asset Size fields are not necessary.

5. Click in the Attachment field, then click the ‘Attach a File’ button, which will
allow you to browse for your downloadable. When you find it click open.
The taxonomy fields are identical to those in content.
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CREATING NEW PAGES

1. Click on ‘Create a New Page’. E Create anew page
The page is split into 2 main parts: ‘Page Information’ and ‘Content’.

PAGE INFORMATION

Page Information: Morway Home

General:
Site: T Morveay =]
Page Title: T Moryeay Home
HTHL Title: T Morway Home 4
URL: flobalfigcr nefMorwayMorway _Home
Taxonomy:
Courtry: Tharwary =]
Incustey: |
Service Line: F =l
Topic: e |
Language: “Narwegian =
Document Type: |
E&Y Specific: e |
w Meta Tags
Search welkammen; til; higmmesiden; Ernst, Young, Morge T Ernst & Young, Revision; Konsulert; Skatt; Svgift; Corporate
Keywards: Finance;, Revizor 4
Presvent Robot
Indexing: r
Description of — “elkommen til hjemmesiden for Emst & Young i Norge o
Cortert:
b HTML Tags
Security:
Yuho is this page T Lize OdgrenOstoErmstyoungMO =]
assigned to:
Workflow:
Status: T Puklizhed =]
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» General - Choose your ‘Site’ from the pop-up menu (e.g. International) and add
a ‘Page Title’. Note punctuation guidelines for titles:

Safe to Use Do Not Use in Titles

Asterisks * Apostrophes *

Exclamation Points ! Colons :

Hyphens - Commas,

Semicolons ; Periods .

Tilde ~ Question Marks ?

Underscore Slashes (forward or backward) \ /
Spaces

Please do not change the title of pages once they have gone live on the
web as the title of the document becomes the URL.

Please note that short, sensible, intuitive titles are best for ease of site
management. Recommended conventions:

Home Page:
US Home

Business Units (examples):
Welcome - AABS

Services - AABS
Services~Audit - AABS

Primary Sites (examples):
Welcome - News Room
090200 - Release

Paths - Career Center

Please do not overly abbreviate titles as users will not be able to understand your
abbreviations when they are pulled by search engines.

HTML Title - Added in response to GCR user feedback, this allows you to choose
a different title to be visible in the browser than the one that becomes part of the
URL. This field is automatically filled in, but may be changed

» Taxonomy - Complete the relevant pop-up menu fields. It is only necessary to
use one of the Ernst & Young organizational coordinates (Service Line,
Industry, Topic or E&Y category) though you may use more than one. Please
do not neglect to fill in the Language field, Country field or Document Type field
as these are used by the ey.com search engine.

* Meta Tags -
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» The search keywords field is automatically filled by the page taxonomy and
words extracted from the description field. You may add additional
keywords between the brackets.

* Check Prevent Robot Indexing if you would like external search engines to
ignore this page.

» The description of content field should be filled in so that the ey.com search
engine results for your site will be most helpful, and so that external search
engines will be able to provide a proper description of your site.

« HTML Tags - It is not necessary to use these fields on ordinary pages. These
fields are used for special programming on individual pages.

» Security - This defaults to your own name or team. Leave as is.

» Workflow - Assign a level from the pop-up menu options: ‘To Do’, ‘Dratft’, ‘For

Review’ and ‘Published’. Only ‘Published’ content will be located by the internal

search engine.

Please do not mark your content as Published during migration, as your half
finished pages will be pulled by the search engine. Once your site has been
approved for launch the Shared Services team will mark your pages
published.

Important Note: All content, regardless of workflow status, will be
pushed out to the live site (except for Working Copies).

33



CONTENT

Content:
Format:
Page Typer  TwvShwG xg  Section Template: "asBS =y Page Layout: (O 1 column

@ 2 columing
(2 columing Fotating

Enter your content here:
Firzt Colurnn:
.

[=h1=5hared services: reaping the benefits</h1=]
A brochure published by our management consulting practice in the UK

The pressure is on for large companies to improve profitability, increase shareholder value, and
focus on market penetration. In response, corporations are being forced to increase efficiency and
eliminate unnecessary averheads.

Caompanies are realizing that a fully staffed office is not needed in every operating location,
reinforcing the trend toward sourcing products and services and the outsourcing of non-core
activities. Our brochure explaing how shared services can reduce cost, increase flexibility, and
improve service guality.

* Format - Next to ‘Page Type’ either WYSIWYG or HTML should be selected
according to the preference in your Profile.
Please do not change from one format to the other as unpredictable errors
may occur.

» Section Template - Select the appropriate template from the pop-up menu e.g.
Careers, Corporate Finance

Caution: Changing this field after a selection has been made can lead to
formatting errors - Ensure the most suitable page development type has
been selected and keep using it.

» Page Layout - All underlying pages are one column. Welcome pages are two
columns (the first column is the feature section and the second column contains
the secondary navigation and the “also see” column). Two column pages may
also be used for press releases with assistance from the Shared Services team
(see US site). The two column rotating template can be used to present three
different “packages” of content on your site’s home page. The blank template is
used for splash screens.

» Enter Your Content Here - This is the body of the document. Enter all your
content here: text, images, downloads etc., (Details below).

2. Press Ctrl and S to save your document. Do this immediately after entering a
page title and repeat it often while creating a page. This will help to minimize
the impact of Replication or Save Conflicts, which occur when two people work
on the same page at the same time.
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3

4.

C

@ WA Presview

. Click on Web Preview to view your page in a browser.

Remember to Save immediately before you view your most recent page
additions. If you need to make more changes, leave the browser open,
return to the GCR and make this edit, save the document again, click back
into your web browser and click the refresh button.

REATE LINKS (EXTERNAL, INTERNAL)

Position your mouse cursor where you want the link or image to appear.

Click on ‘Insert HTML Tag’ on the top tool bar.

A Insert HTML tag ™

This calls up a dialog box with four options: Link, Image, Download and Email
Link. To link to another web page, select Link.

L |

Inzert:

E mail link,

[J CREATE EXTERNAL LINKS (OUTSIDE OF EY.COM)

In the ‘Extended URL’ field, type in the URL of the page you wish to link to.
Click OK to return to your document and see the link you've created, like:

[<a href="http://cnn.com”>CNN</a>]

If you are using the external link or email tool, it is essential that you turn
off an option in your Notes preferences as follows:
* In Notes, select File->Preferences>User Preferences
e The second option in the Additional Options box is
Make Internet URLs (http://...) into Hotspots
* Please turn this option off (make sure it is NOT checked)
In your emails, web addresses will no longer be “clickable.” However, leaving
this option enabled and using the external link or email tool will cause broken
links.
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[J CREATE INTERNAL LINKS (WITHIN EY.COM)
Use the drop down box to choose the international site or an individual country

1.

N

o o

site.

Choose a Taxonomy Coordinate by clicking a radio button.
Scroll down the list in the next box to select the top level value.

(If you want to look at the International site by Industry, pull down the site menu
and select International. In a moment the top-level industry values will show up

in the box.)

If necessary, scroll down the list of second-level values in the next box.

Finally, scroll through the list of document in the final box. Click on the

document you want to link to.
Click OK to return to your document and see the link you've created, like:

[<a href="/global/gcr.nsf/international/international_home”>Home</a>]

Inzert Link

Link type: " External @) |ntemnal

— Internal Link Select:
Site:

| |nternational jl

T axanarmy:

1 Industries (& Topics
Cl Services (! EY Categories

G lobalization
Rizk M anagement

Subcategon:

Capahilities
Datcom
Inzights

— Properties:

Link. text:

X Ovenwrite

|Librar':.f
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CREATE IMAGE LINKS

Inzert Image

Site: ICanada j Image: [people organiz -
process transform
Coordinstes IServices j
h -
Services: IManagement Consulting j Sl
Add To bty Images |

File Mame: Image Previewy: W space:

strategy jpg | = | "0 |
Description: H Space:

strateqy |"' 0= |

Border:

Size: . |r 0 = |
|122:-:114 | Wrap:

Alt Tag: [ Crververite @® Do Mot Wirap

T strategy o O virap Lett

- O wirap Right
4 I I [

1. Click on ‘Insert HTML Tag'.
2. Select ‘Site’.
3. Select ‘Coordinate’. You may browse by Taxonomy, Image Type or Image

Concept, or My Images.
Select ‘Value’, ‘“Type’ or ‘Concept’.
Select an image from the list at right. Shortly you will be able to view the
selected image in the ‘Image Preview’ windowpane.
6. Complete the fill-in fields for 'V Space’, ‘H Space’ and ‘Border’; generally all
should be zero (0). Choose a ‘Wrap’ option.
» Do Not Wrap isolates image on its own line with no text beside it. Please
choose this option for all lozenges.
» Wrap Left places the image on the left side of the column with text filling up
the space on the right.
» Wrap Right places the image on the right side of the column with text filling
up the space on the left.
7. Click ‘OK’ to select your image and return to the previous menu screen.

S

Rather than reusing the Insert Image tool, it's very simple to paste the code for the
image into different spots on the page. You may also try modifying the wrap
options by changing the ‘align’ attribute, i.e. if it says ‘align=left’ try ‘align=right’.
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If you would like to preselect all of your images before you start building a
particular page or subsite, the 'Add to My Images' button is very helpful. Follow the
directions below up to step 5 to find the image you'd like to use. Click the Add to
My Images button, then browse for more images. Once you've found all of the
images you need, begin developing your page. When you're ready to insert an
image, instead of browsing you can choose the last option in the Coordinates list,
My Images, and continue with step 6.

CREATE EMAIL LINKS

If you are using the external link or email tool, it is essential that you turn off
the Make URLs into Hotspots option in your Notes preferences as described
above, in the section on External Links.

1. Click on ‘Insert HTML Link’.
2. Select ‘Insert Email Link’. For Ernst & Young addresses, use external
addresses rather than Lotus Notes ID’s.

Insert Email

]|
Eriter the e-mail rit to link to:
| (=18 eema_l O YWY S| I:Ill'l (n] |

(&0 Weheditor@eyuk com) Cancel |

Enter the text for your link:

[e.q feedback)

3. Complete the 2 fill-in fields shown above using the accompanying examples as
your guides.
4. Click ‘OK’ to finish and return to your page.
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CREATE DOWNLOAD LINKS (LINKS TO PDF’S AND OTHER VAULT FILES)
1. Click on ‘Insert HTML Link’.

2. Select ‘Insert Download Link’.

3. The following dialog box appears.

Inzert Download

X
Select Azzet | ok |
_Caree |

Cancel

File Mame: | |

Attachmerit Name:| |

Site: | |

E Cveryytite

Lirk Text: | |

4. Click ‘Select Asset’. A new dialog box appears to help you select the relevant
asset in the Global Vault.

AssetsbySie __H|
Select asset; Ll
Weh Assets hy Site :I Eemee] |
* |International
k AABS
bk About ESY

F Automotive & Industrial Products
b Corporate Finance
* pBusiness _|

I

The Connected Society: Winning the Mesw =55
Battle for the Customer

b Energy
b Entrepreneurial Services
¥ Euro/European Union

bk Fiumawmaial Cnmdana x
| | r

5. Select the appropriate asset. Click ‘OK’ to return to the ‘Insert Download’ menu
screen.

6. All the relevant fill-in fields have been completed automatically, based on your
selection:
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Inzert Download

]|
Select Azzet | ok |
_Caree |

Cancel

File Mame: | Mordic A=zzet Management Survey |

Attachment Name:| nardic azset management survey o |

Siter | Sweeden |

% Crverawrite
Link Text: | 0Ur latest survey |

7. Type in Link Text.
8. Click ‘'OK’ to complete the download link and return to your page.

CREATE TABLES

The design standards for ey.com do not permit the use of columns to format
articles in newspaper style, and it is not necessary to use tables to align images as
site managers can do so using the Wrap options provided in the ‘Insert Image’
tool. Thus, the only recommended use of tables is for discrete items of data, such
as a spreadsheet or contacts list. Also, creating tables within the ‘Also See’
column causes problems. We strongly recommend against the use of tables in
‘Also See’ columns.

Any tables on ey.com should have a white background and should use no more
than a 1 point border.

The process for creating tables in WYSIWYG pages is the same as the process

for creating them in Notes email. Please refer to your Notes help files or manual
for further assistance.
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EDIT EXISTING PAGES

Important Note: We recommend that users develop their entire site in either
HTML or WYSIWYG format. Converting between the two formats is tricky and
often causes unpredictable errors.

[J WORKING IN WYSIWYG

Lotus Domino can be unpredictable in how it translates WYSIWYG documents
to the Web. Most problems can be avoided using the following guidelines.

First and foremost, always use Arial as your font and do not use any other color
than black. Not only is this required by the design standards for ey.com, it is
also necessary to keep Domino from generating pages with mixtures of fonts.

The status bar on the lower left displays the font face, point size, and style
applied to text. All text in a WYSIWYG document should have no style applied
to it, so the style field should read [None].

As these are Web pages, it's necessary to insert HTML into them. Domino
cannot distinguish actual HTML code from text meant for WYSIWYG display
without a cue. There are two options:

Square Brackets are the preferred option. They are easy to see and apply. All
HTML inserted by the GCR tools is enclosed in square brackets, for example
[<a href="http://www.xxx.com”>A typical link</a>]

Pass-thru HTML is an option under the text menu. It sends the same message
to Domino as do square brackets, but this formatting is not conveniently visible
in Notes 4.6. In Notes 5 this flaw has been fixed and HTML-formatted text
appears shaded grey.

Please do not enclose HTML code in square brackets AND format it as Pass-
thru HTML. This is easily misread by Domino.

[J WORKING ON LIVE PAGES

If it's a quick fix (a typo, a news brief, etc.), just make the update, preview it right
away and make any adjustments necessary. Within 30 minutes your update will
appear on the live site. Please be cautious when making fast updates such as
these. In most cases, it makes more sense to make a working copy.
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CREATE WORKING COPIES

Working Copies are designed for making updates to published pages. Edits
may be made to a ‘working copy while the old version remains live on ey.com.

To create a ‘Working Copy’:

1. Clicking once on the document you need to work on.

2. Clicking the Tools button.

3. Selecting the ‘Make Working Copy’ option.
You can also make a working copy if the page you need to work on is already
open:

1. Click on the ‘Other Tools’ button. Ml

2. Select the ‘Make Working Copy’ option (first in the list) when the following
dialog box appears.

ools |

Select a toal, 0K

Check Links
Check Speling

Copy [relative] WALt clipboard
Copy [abzaolute) URLba clipboard
Inzert Section Mav include

Cancel

Now open up the Working Copy (in the view, Working Copies are identified
by a little pencil) and make your changes.

3. Once you have made your changes and they are working correctly, click the

Replace Original Copy button at the top of the page.

4. Esc to exit document and return to previous menu screen.
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FIX BROKEN LINKS

Broken Links are assigned to the individual who worked on that document last.
Broken links in any of your pages should be detected by the ‘Broken Links Agent’
which will run regularly and check all pages that are marked as "published" for
broken links. It then creates a report for every page that contains a broken link.
These can be accessed from the main navigator in the GCR by clicking the ‘Admin
Tools’ button and then ‘Broken Links'.

[J INSTRUCTIONS

» Enter the GCR.

» Click on ‘Administration’ in the left hand menu column. A sub-menu appears.
* Click on Broken Links.

» Using the twisties scroll down to the relevant document.

» Click on the relevant entry. This opens up the menu screen below:

Broken Link
created Mon 044722000 by Domino Agent
Site: us
-cliu:k here to view the page
Page Title: Success - Retail & Consumer Products - Ernst & Young LLP

Page Owner: CH=Laura M. Jacobs/0U=RGH/OU=MC/O=E¥YLLP/C=US

Broken Links:
http:/M199.51.101.87 /globaliger.nsfimages/SF3AS92700E1 8E10802568100063352F $FILEblan
k.gif

himk: HTTPA .0 404 Mot Found
http:/M199.51.101.87 /globaliger.nsfimages/SF3AS92700E1 8E10802568100063352F $FILEblan
k.gif

himk: HTTPA .0 404 Mot Found

* Use the button next to ‘click here to view page’ icon to open the page
* Once you have fixed the broken links on a page, delete the broken links report
for the page.
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ABOUT WYSIWYG - A CASE STUDY

[J CONVERTING A WORD DOCUMENT TO A GCR DOCUMENT

Once you've migrated your site to the GCR, adding new pages will often be a
matter of converting Word documents submitted by your content providers. Of
course every page will be different, but in this mock page we’ve tried to provide
examples of many layout tasks you might encounter.

Here is the source document:

Lorem Ipsum

Lorem ipsum dolor sit amet, consectetur adipiscing elit, set eiusmod

tempor incidunt et labore et dolore magna aliquam. Ut enim ad minim
veniam, quis nostrud exerc. Irure dolor in reprehend incididunt ut

labore et dolore magna aliqua. Ut enim ad minim veniam, quis nostrud
exercitation ullamco laboris nisi ut aliquip ex ea commodo consequat.
Duis aute irure dolor in reprehenderit in voluptate velit esse molestaie
cillum. Tia non ob ea soluad incommod quae egen ium improb fugiend.

e Officia deserunt mollit anim id est laborum
e Et harumd dereud facilis est er expedit distinct.
e Nam liber te conscient to factor tum poen legum

odioque civiuda et tam. Neque pecun modut est neque nonor et imper
ned libidig met, consectetur adipiscing elit, sed ut labore et dolore
magna aliquam is nostrud exercitation ullam mmodo consequet. Duis
aute in voluptate velit esse cillum dolore eu fugiat nulla pariatur. At
vver eos et accusam dignissum qui blandit est praesent. Trenz pruca
beynocguon doas nog apoply su trenz ucu hugh rasoluguon monugor or
trenz ucugwo jag

scannar. Wa IdfoBraid dusgrubuguon.
hava

IdfoBraid dusgrubuguon. scannar. Wa hava
dusgrubuguon. scannar. Wa hava IdfoBraid
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Dolor Sit Amet

scannar. Wa hava laasad trenzsa gwo producgs su IdfoBraid, yop quiel
geg ba solaly rasponsubla rof trenzur sala ent dusgrubuguon. Offoctivo
immoriatoly, hawrgasi pwicos asi sirucor. Thas sirutciun applios tyu
thuso itoms ghuso pwicos gosi sirucor in mixent gosi sirucor ic mixent
ples cak ontisi sowios uf Zerm hawr rwivos. Unte af phen neige pheings
atoot Prexs eis phat eit sakem eit vory gast te Plok peish ba useing phen
roxas. Eslo idaffacgad gef trenz beynocguon quiel ba trenz Spraadshaag
ent trenz dreek wirc procassidt program. Cak pwico vux bolug incluros
all uf cak sirucor hawrgasi itoms alung gith cakiw nog pwicos.

First, survey the initial document. This one has a headline, bold, italic, and
underline text, bullets, and a table. All of this formatting will carry over into the
GCR.

[J STEP 1: PREPARE TO COPY TO THE GCR

Select all text (ctrl-a) and select Format->Font. Change all text to Arial 10pt.
Close out the formatting box and copy all text (ctrl-c).

[J STEP 2: PASTE INTO GCR AND PREVIEW

Create a new WYSIWYG document in the GCR and paste the content into the
content field. Complete all necessary fields for title, taxonomy, meta data,
section template, etc. Save the document and click ‘WWW Preview'. In most
cases, you'll see that the page looks good and just needs some formatting, links
and graphics.

[J STEP 3: CLEAN UP CHARACTER FORMATTING
Bold and italic formatting is permitted on ey.com, but underlined text is not.
Underlines are used on the Web to indicate a link, and using an underline as a
mere formatting convention is confusing to users. The underlined phrase in the
first paragraph should be reformatted in italics, bold, or both.

To properly format headlines and subheads, it's necessary to use a little HTML,
as follows:

headline: [<h1>Lorem Ipsum</h1>]

subhead: [<h2>Dolor Sit Amet</h2>]
H1 and H2 are code which instruct the browser to check the style sheet.
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[J STEP 4: ADD SECTION NAVIGATION

Ensure that the proper section template is selected, and place cursor before the
square bracket that begins the headline and use the ‘Insert Section Nav’ include
option in the ‘Tools’ dialog box. Alternatively, you may open another GCR
document that shares the same section template and simply copy the ‘Section
Nav Insert’.

[J STEP 5: ADD LINKS AND IMAGES

Processes for adding downloads, links, and email links are explained in How
To.

[J STEP 6: FINALIZE & PUBLISH

Preview the page and fix any remaining errors. If necessary, use the ‘Request
Review’ option in the ‘Workflow Tools’ dialog box. Once the page is ready, mark
the Workflow status as ‘Published’ and add links to the page from other pages
on ey.com.
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SITE GRAPHICS PRODUCTION

The professional production of ey.com graphics is essential to the appearance of
the site. A suite of tools is available for all of us to use worldwide, so that the
quality of graphics will remain consistently high.

The process for creating graphics is simple. The PhotoShop templates have all of
the design aspects predetermined. You only need to change the type and save the
image for the web.

TOOLS

If you do not have the Barmeno font on your computer, you will need to
install it before you can create the graphics. You will need to install Adobe
Type Manager as well to facilitate installation of the font. Detach both of
these files from the International>Not Categorized section of the Global
Vault.

Double Click the Adobe Type Manager executable file to unzip and install
ATM. When prompted to enter the serial number, type this number:
AWW400R2106310-286 into the field.

You'll be prompted to restart your computer. After installation you may
experience a change to the appearance of your text displayed by your
computer. Opening the ATM application by hitting the START button,
Program Files, Adobe and finally Adobe Type Manager Deluxe.

Unzip the the Barmeno file and have ATM add Barmeno to your system.
Remember to put a check in the box to activate the new font.

Next, you will need to download and unzip the PhotoShop Graphics Tools,
available at:

http://www.ey.com/international/processes_-_graphics_-_insideout
[Look for a new InsideOut in a few weeks. The url for this page will change
to: http://www.ey.com/insideout/processes - graphics_-_insideout]

There are two main types of graphics: those with single color backgrounds and
those with multiple color choices for backgrounds. Instructions follow for creating
each of these types.
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GRAPHICS WITH SINGLE COLOR BACKGROUNDS

SECTION HEAD

TAX

You will create more Section Heads than any other graphic. To begin, assess the
length of the text you need to add. Most can fit on one line, but you have the
option of using a two line version.

Open PhotoShop 5.5, and open the folder labeled Headers. Choose the one or
two line template.

This template has only three layers: a white background, a horizontal rule, and
type. You will only need to modify the type layer. If the Layers palette isn'’t visible,
select Windows—>Show Layers. Doubleclick on the word “Type” in the layers
palette to open the Type Tool. Replace the words that are there with your text.

Please note: Section Heads should be created in ALL CAPITAL LETTERS.

Select File>Save for Web and under settings make sure GIF, Perceptual and 32
colors are selected.

Click Ok, give the file a name that is clearly identifiable (ie Tax rather than
header_practice_name_1line).

Attach this image to the resource document as described earlier in this manual.
Other graphics that are created the same way:

0 All of the left hand navigation
[0 Title graphics for primary sites, for example:

NEWS ROOM

[0 Subheads with attached rules for primary sites & home page, for example:

E&Y News Now

GRAPHICS WITH MULTIPLE COLOR CHOICES FOR BACKGROUNDS (LOZENGES)

The process for creating lozenges is essentially the same, except that you will
Save for Web multiple times, each time with a different color lozenge. If other
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countries have already made the lozenges you need in your language, you are
free to use these graphics on your site as well.

All of the lozenge color options are already included in the template. All that you
will need to do is modify the text using the Type Tool and make various layers
visible to make different color lozenges. For example, to make a green Also See
lozenge:

Zloz also_see... MMmpQ@ | ___________________F

%]
+ID. o |1I L |2 Layers Channels Fath= ﬂ

il LAty [Marrnal | Cpacity: |1I:IEI I‘I #
Also See @

— ¥ Freserve Tranzparency

& ||_ 3] Eve lcan [-
50
[ ||_ [=—_] Lozenge Red
[ ||_ [F=—_] Lozenge Elue
[ ||_ [=—_] Lozenge Purple
[ ||_ [E==] Lozenge Yellow
& ||_ [=—_] Lozenge Green
B ||| sestrvans

DO D DD

Visible layers are marked with eye icons. To make a layer invisible, click on the
eye icon, and to make it visible, click in the empty box.
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NUDGING

If you need to make your lozenges larger, please use the following procedure:

1. TYPE IN YOUR NEW TEXT FOR THE LOZENGE:

Either make a new type layer: Or edit an existing type layer:
e Click onthe T to use the Type tool ¢ Double click on any of the type
e Click inside the frame of layers in the layers palette
Lozenge.psd » Change the text visible in the
* An empty type dialog box will come type dialog box
up

e Type in your new text (use
Barmeno Medium, 18 pt)

2. IF THE TYPE IS LONGER THAN THE LOZENGE, YOU'LL NEED TO NUDGE IT.

ﬁ Lozenge.psd (@ 100X [A very very very long title. RGE]
+ [u] 100 150 200 250 200

f=tu}
I A very very very long

Keep the type layer visible to use it as a guide.

In the layers palette, click on the lozenge layer you would like to enlarge.
Click on the Marquee tool

e

1
L.

Select the end of the lozenge. Be sure to select from the very top to the very
bottom of the image, and to include all of the shadow.

E Lozenge.pzd (@ 100% [A very very very long title. RGE]
¢ [u] 150 |EI:IEI 250 |3I?D |3$D |4I%II:II

S0
[a VEry very very long s

A

Hold down all at once the Ctrl key, the Alt key, and the left or right arrow key. In
this example | used the right arrow key.

Continue to hold down the Ctrl & Alt key, and keep pushing the arrow key to nudge
the lozenge one pixel.

50



To nudge the lozenge 10 pixels at a time, hold down the Ctrl, Alt, and Shift keys as
you push the arrow key.

Ultimately, the space on either side of the type should be equal:

A very very very long title

IF THE TYPE IS SHORTER THAN ALL THE LOZENGE WIDTHS AVAILABLE, YOU CAN ALSO
NUDGE IT SMALLER.
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PHOTOGRAPH FINISHING

All of the photographs on ey.com have rounded corners and a subtle drop
shadow. These modifications harmonize with the other design features of the site
and help ey.com maintain its consistent look and feel.

It's very simple to apply the rounded corners to photos. In summary, the process
is:

» Paste the new photograph into photo masking file, in a layer beneath the mask
» Scale the photograph so that it fits within the mask

» Save for Web

The step-by-step directions below will guide you through creating masked
photographs.

First, you need to download the photo masking tools:

http://www.ey.com/global/gcr.nsf/international/processes_-_graphics_-_insideout
[Look for a new InsideOut in a few weeks. The url for this page will change to:
http://www.ey.com/insideout/processes - graphics_-_insideout]

Begin by opening Photoshop 5.5. Open the source photo you want to work on,
select all (Ctrl-A) and make a copy (Ctrl-C). Close the source photo.

Open the most suitable template from the photo_masking_tools you downloaded
from the ey.com site." In the Layers palette, click on the layer labeled “replace this
image.” Paste the source photo (Ctrl-V). It will be added as a new layer above
“replace this image.”

If when you paste in your image you don’t see the mask and your source photo fills
the entire canvas, you need to move the layer. In the Layers palette, click and
drag your source photo so that it moves beneath the “mask cut-out” layer.

Generally your source photo will be too big or too small. To resolve, make sure the
source photo layer is active and select Edit=»Transform=>»Scale. You'll see a
border and white guide boxes will appear around the periphery of the image.

Place your mouse at the bottom right-hand corner of the template image. If your
mouse is properly over the lower right-hand corner guide box you should see a
two-headed arrow bisected by a very short line.

* If the proportions of your image do not work with the proportions of the mask, save a new copy of the mask and select
Image-Image Size. At the bottom of the dialog box, make sure constrain proportions is not checked. Change the size of the
image to the size you want, then proceed as above.
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Depress the shift key and the left mouse button while dragging toward the upper
left-hand corner of the image if the image is too large, or away from the upper left-
hand corner if the image is too small. Holding the shift key constrains the
proportions so you don't distort the image.

You may also click anywhere inside the border and drag to move the image within
the mask. When you are finished, hit return.

If you find that you are not happy with the scale you've chosen, do not
Edit=» Transform=>»Scale again. First, open the History palette and click on the
step above “Free Transform.” This will undo all of your scaling so you can start
over. Please use this approach rather than enlarging and shrinking the image
repeatedly, which will cause the final image to become fuzzy.

When you are satisfied, select File=»Save for Web...
Under settings, in the top left drop down box, choose JPEG.

Experiment with the drop down box underneath. Higher quality images look better
but lower quality images are smaller files which means the page will download
faster. File size and estimated download time is indicated in the lower left hand
corner of the screen. Strike the right balance and click OK to save the JPEG. You
will also want to save the PSD file. You can use this mask file over and over again,
just adding layers.
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GCR TERMINOLOGY

COORDINATE
One system for classifying knowledge within a taxonomy. The ey.com taxonomy
has eight coordinates: Country, Service, Industry, Topic, Document Type,
Language, E&Y Specific, and Image Type.

DHTML
Abbreviation for Dynamic Hypertext Markup Language, the type of code used to
create the “fly-out” site wide navigation.

FOOTER
The standard information about the firm & site which appears at the bottom of
every page. Generally contains a copyright notice, a link to a legal disclaimer, and
a link to webmaster email.

HIERARCHY

The tiered (layered) series of levels within the database. e.g. ‘Parent’ and ‘Child’
relationships within a taxonomy. Some ‘Parent’ values have ‘Child’ values beneath
them. For example, ‘Child’ values of AABS include Due Diligence and Internal
Audit.

HOME PAGE
The first page of content users find when they click on a link to your site. Each
country or regional site has only one home page.

LOZENGE

for example: m Ej

Colored oblong graphics used to demarcate sections of pages on ey.com.

SECTION NAVIGATION
Navigation at the page level within a site. For business unit sites, usually consists

of:

Welcome
Overview
Services
Success Stories
Library

Contact Us

TAXONOMY

A hierarchical, controlled vocabulary used to categorize and/or classify a large
body of information.
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TWISTIE

Small triangles to the left of each value/category in a Notes database, indicating
that it can be opened. Clicking on the twistie will reveal the documents which have
been assigned that value.

UNDERLYING PAGE
Content pages accessed by links from Welcome Pages. Underlying pages are
always one column.

VALUE
Individual terms within a taxonomy coordinate. For example, values of the Service
coordinate of the ey.com taxonomy include Tax and Management Consulting.

VAULT
A database that is separate from the GCR, which houses downloadable
documents (Adobe Acrobat files, Excel spreadsheets, applets).

VIEW
Lotus Notes’ means of displaying the content stored within a database. View
examples: your email Inbox, the GCR’s My Profile, GCR Content by Site, etc.

WELCOME PAGE

Initial page of a subsite, for example the Tax or Career Center. There are several
welcome pages on a country site, but only one home page. With very rare
exceptions, Welcome Pages are always composed of two columns.
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